11/29/2005 - 5:00 pm - 6:30 pm Room:Lark 1/2 (Swan)

AUTODESK
AW UNIVERSITY
2005

Walt Disney World Swan and Dolphin Resort
Orlando, Florida

Autodesk® Architectural Desktop: The Facility Manager's
Dream
David Shepherd - Universal CAD Ltd.

FM22-1 The combination of new Architectural Desktop 2006 features, such as Display Themes and Database
Fields, together with ADT Areas, Spaces, and Scheduling make the software a formidable out-of-the-
box solution for facility managers. This session will demonstrate how easily room booking, asset
tracking, and lease/chargeback data can be linked into ADT 2006 without complex programming or
recourse to third-party applications.

About the Speaker:

Dave worked for Autodesk for over 7 years as senior technical trainer for Architectural Desktop and
AutoCAD. In that role, he trained hundreds of users in over 30 countries throughout Europe, the
Middle East, Africa, and in the US. He also held editorial responsibility for several Autodesk Official
Training Courseware titles relating to Architectural Desktop and AutoCAD. Before this, he taught
collegiate-level courses in AutoCAD. He has used AutoCAD as a design tool for over 22 years. He is
an Associate of the Chartered Institute of Building, and his many years of experience in building
design have served to make his presentations all the more relevant to the needs of his audience..

david.shepherd7@ntlworld.com






FM22-1 David Shepherd, ACIOB

ADT2006: The Facility Manager’s Dream

Training Summary

Many facility managers are using database applications (bespoke or off-the shelf) to
manage facility requests, work orders, departmental lease/chargeback sytems.

This paper describes how the combination of AutoCAD database connectivity and
ADT Area Objects and Property Sets can be used to present facility data with greater
clarity and ease of manipulation.

We begin with a review of the ADT2006 Property Set feature. We look specifically at
the joining of database records to Spaces and other objects via the Property Set
feature.

We consider the creation of a simple room booking system in Microsoft Access and
link the database entries to a plan drawn in ADT.

We also use the AutoCAD Database Connectivity feature (dbCONNECT) to update
the database from within ADT. Then, we run a SQL query and return the results.

Multi View Blocks representing furniture and fixtures are associated with specific
rooms using the location property and a schedule of this is generated.

I shall also demonstrate that formulas (R/U ratio, plaster deductions, etc.) can be
integrated into the Property Set data and viewed within the ADT session by using tags
and schedule tables.

For Space Analysis, I shall demonstrate the use of Areas to produce a colour map of
departmental room assignment. These rooms are assigned to departments via the Area
Group feature. Display themes are used to present important asset data in a more
effective visual manner.

We will conclude the session with a demonstration of ADT Asset Tracking methods
and recommendations on the use of DWF as a format for electronic distribution of
your reports.
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ADT Property Sets

What is a property set? A property set is collection of defined non-graphical data that
we can associate with any object in ADT or AutoCAD.

Property Definition Examples: Manufacturer, Cost, Lease rate per square foot, Net
Usable Area, Serial Number, Department, Owner, etc.

The Property Set is a specific group of these property definitions.

There are a variety of Property Definitions that are differentiated by the method by
which they are generated.

1. MANUAL PROPERTY DEFINITION

This property definition is typed in manually rather than derived from an object
parameter. Manufacturer, Lease Rate, Serial Number and Department are all
examples of manual properties.

2. AUTOMATIC PROPERTY DEFINITION

This property definition is automatically derived from an object parameter. Examples
include space area, building project level, door width/height, etc.

3. FORMULA PROPERTY DEFINITION

This property definition is derived from a combination of other properties. We could
multiply Net Usable Area by Lease rate per square foot to obtain the Lease Income
for a given area.

Complex mathematical formulas can be developed through VBSCRIPT
programming.

4. LOCATION PROPERTY DEFINITION

This property definition is derived from the property of an associated AREA or
SPACE object. For example, you could place a piece of equipment (defined as a
Multi-View Block) within a specified area. When you add the location property to the
block, ADT attaches a visible spline with a star-shaped grip to this object. The
placement of this grip on a given AREA or SPACE extracts a property set data from
that AREA or SPACE.

5. CLASSIFICATION PROPERTY DEFINITION
Classification is a method of differentiating objects of the same style or block

definition. This provides an easy method of distinguishing types of equipment and
fixtures for scheduling without recourse to layer filters.
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You might want to distinguish third floor windows from ground floor windows
within a curtain wall and then apply a Work Order number within the Property Set to
those that need repair. You apply a schedule to specific levels of windows by way of a
Floor level Classification that is applied to Window Styles.

6. MATERIAL PROPERTY DEFINITION

ADT material definitions are used to define the display of an ADT object style for a
variety of drawing types: plans, elevations, sections, 3D models, etc. You can apply a
property such as FINISH to a material definition. Let’s say that the value of the
FINISH property is Limed Wax and this material definition is applied to a Door Style.
We can extract this value through the Material Property Definition.

7. PROJECT PROPERTY DEFINITION

The Project Navigator was introduced in ADT2004. This interface allows you to
assemble a building model from the major arrangements of building components,
such as individual floors and the external shell. You can assign each floor drawing to
a specific level. The level number or ID is a project property. If you want each room
on a given floor to begin with the level ID. You can create a formula property that
appends the two-digit room number to this level ID, e.g. 101, 102, 103, etc.

For any property definition, ADT warns you about using spaces in the Name input
box. When you create a schedule tag from a property set, the property name is used to
create an attribute within the tag block. AutoCAD prevents you from using spaces in
the TAG of an Attribute Definition.
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Inserting a Database Record as Manual Property

First, how do we add the property set to a drawing feature? There are three accepted
methods of doing this. We can:

1. Tag the object. (See Scheduling Tool Palette). The action of adding a schedule
tag to an object attaches the property set. This is the property set that was used
to create the tag in the first place.

2. Right-click the object and select Edit --- Style. This opens the Style dialog
box. Under the General tab, select Property Sets... By clicking on the Add
Property Sets icon, we can view and apply a Property Set to the entire object
style.

3. Right-click the object and select Properties... This opens the Properties
Window. Under the Extended Data tab, you can select any property set that
can be applied to this object. The property set must reside in the same drawing
file. If not, you must import it through the Style Manager.

Once you have added a property set, you can edit the value of any manual property.
The Data Format Style within each property controls the presentation of the value.
An Area Data Format Style might have the suffix Sq. Ft. However, be aware that, if
the Area is used in a formula, this suffix will prevent ADT from completing the
calculation. The remedy is to define an extra formula property that simply contains
the text: [Area]. You can then apply the Sq.ft. suffix to this.

If you right-click on any Manual Property under the Extended Data tab, there is an
option to Insert Field... With ADT2006, the AEC Database Field Category was
added. This allows you to insert a database entry as manual property value. You can
insert a table value from any ODBC-compliant database and update its value from the
database itself. If you do use MS Access, ensure that you select Microsoft Jet 4.0
OLE DB Provider.

By repeating this for a number of Manual Properties, you can add a complete database
record to any ADT object. This is particularly useful when you want to tie asset data

to the corresponding symbol on the plan.

In the following example, I have inserted the room number as a property of each ADT
space by the above method.

We open the file, First Floor Plan from the Constructs Tab in the Project Navigator.
We can generate spaces for every room with the Space Auto-Generate tool.

We then tag each space with the Room Tag Tool (Scheduling Tool Palette).
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Worked Example: Creating and Linking a Room Booking Database

Let’s create a table and call it Booking. I have listed the Field Names and Data Types
below:
Table: Booking

Field Name Data Type
1. | ID AutoNumber
2. | Room Number
3. | Arrival Date/Time
4. | Checkout Date/Time

Populate the fields of the Booking Table with the following data (Dates are in
M/D/YY format):

ID | Room Arrival Checkout
1 | 101 9/6/99 9/10/99
2 | 101 9/12/99 9/17/99
3 1103 9/2/99 9/9/99
4 104 9/1/99 9/2/99
5 1105 9/2/99 9/6/99
Now create another table called Rooms.
Table: Rooms
Field Name Data Type
1. |[ID AutoNumber
(Indexed: Yes)
2. | RoomNum Number

This table contains all the room numbers.

We now add the following data to the Rooms table:
ID | RoomNum
101
101
103
104
105
106
107
108

XR|I[N| N[ [W(|—

Typically, we might run a query within MS Access that returns a list of reserved
rooms for a given date range. However, there is no visual representation of this.
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The SQL query in MS Access would look like this:

SELECT Booking.Room, Booking.Arrival, Booking.Checkout
FROM Booking

WHERE (((Booking.Arrival)>=#1/9/1999#) AND
((Booking.Checkout)<=#9/9/1999#));

It would return the following result:

ID | Room Arrival Checkout
3 |103 9/2/99 9/9/99
4 | 104 9/1/99 9/2/99
5 | 105 9/2/99 9/6/99

You could use the dbConnect feature in ADT to link records to ADT Spaces in the
Floor Plan drawing. We can then create and run the reservation query in ADT.

To do this, you type dbconnect at the command line and press Enter.

You then right-click on Data Sources in the dbConnect Manager and select
Configure Data Sources...

You type the Data Source Name, say, Hotel Bookings and click on OK.

Select Microsoft Jet 4.0 OLE DB Provider on the Provider tab in the Data Link
Properties dialog box, then Next>>

On the Connection tab, you select the Browse... button and navigate to Hotel
Bookings.mdb. Now click on OK.

Connecting the records to the ADT objects

We need to link records in the Rooms table to ADT spaces. To do this, we double-
click on the Rooms table to view. We can then right-click on each record and select
Link! A new link template is created called RoomsLink1.

To distinguish each record, the link template requires a field that is populated with a
unique value for each record. In the Rooms table, this is the ID field. Select this in the
Key Field area of the Link Template dialog box. Click on OK.

Now, you select an ADT space. Repeat the linking for all spaces. You will not be
required to create the Link template for this table and drawing again.
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Running the SQL Query on the ADT objects

We can run the previous SQL query in ADT.
Go to dbConnect? Queries»™ New Query on an External Table...

This opens the Select Data Object dialog box. From here, we select the Booking
table from the Hotel Bookings database

Click on Continue and call the new query ‘Rooms booked between dates’
Click on Continue and in SQL Query input box, type the following:

SELECT Booking.Room, Booking.Arrival, Booking.Checkout
FROM Booking

WHERE Arrival >= TIMESTAMP '1999-01-09 00:00:00' And
Checkout <= TIMESTAMP '1999-09-09 00:00:00'

Click on Store to save the query and Execute. Note that the result is a table and we
have the added benefit that the rooms are highlighted.

Space Analysis with ADT Areas

The Space object has been an important feature of ADT from its inception. ADT2006
introduced several important enhancements. One such improvement is the ability to
display the Gross, Net and Usable Boundaries. In order to activate this feature, go to
Tools» Options...

Under AEC Object Settings tab, locate Space Settings, and check Enable Usable
and Gross Boundaries.

The sample file, First Floor.dwg, was set up to alternate between these boundaries by
changing the display configurations.

Spaces can be generated from the existing building drawing by two methods:

1. Right-click on the Space tool and select Apply Tool Properties to...
Polyline, Slab, or Area.

2. Select the Space Auto Generate tool. In the Generate Spaces dialog box,
select Automatic. Set the Filter to either Walls only, All linework, or Walls,
lines, arcs, polylines and circles. Pick points within each boundary to
generate the required spaces. You can also set the Max gap size to a value that
ignores openings. You should freeze any fixtures and furniture before using
this tool.

Editing Space Boundaries

You can modify the space boundary in accordance with BOMA or IFMB
measurement rules. You will see a small round grip in the middle of each space. Click
on this to enable editing.
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Now you can right-click on the space and select Vertex» Add from the short-cut
menu. Turn off OSNAP (F3) and pick as many new vertices as needed. You can then
grip-stretch these to fit each room shape. You can also grip-stretch the edge of each
space. Note the Ctrl key options that provide flexibility during grip-editing.

To subtract vertical penetrations, right-click on the space and select
Interference™ Add from the short-cut menu. Now select a polyline or AEC object.
This will create an internal boundary that reduces the Usable boundary of the space.

In accordance with BOMA, you can add elevator lobbies and corridors as Usable
Areas for full-floor tenants. You can also see the effect of applying the ‘dominant
surface’ rule by stretching the space to the glass line of the external windows.

Adding Schedule Data to Spaces

To add schedule data, right-click any space object and select Properties... This opens
the Properties Window. Under the Extended Data tab, you can select any property
set that can be applied to this object. The property set must reside in the same drawing
file. If not, you must import it through the Style Manager.

To add a lease rate property, go to Document® Scheduling» Property Set
Definitions...

Click on the SpaceObjects Property Set, and select the Add Manual Property
Definition button.

Type Lease_Rate and click on OK. The underscore (_) ensures that this property can
be used as an attribute in a schedule tag block. You will need two versions of this
property, since any prefix (e.g., $) or suffix in the applied Data Format Style will
generate an error in the formula calculation.

For the formula property, select the Add Formula Property Definition button.
Type in the name, Lease_Total. In the Insert Property Definitions window, select
Lease_Rate and NetFloorArea.

Use these to create the formula, [Lease_Rate]*[NetFloorArea]. Click on OK.

The formula property definition can include VBScript coding. Although it is beyond
the scope of this document, you could include capital depreciation formulas by using

VBScript.

Generating the Schedule Table

You can use a schedule table style, called Space Inventory.

Go to Document® Scheduling®™ Add Schedule Table. In the Properties window,
under the Design tab, ensure that the style Space Inventory is selected. Select the
spaces by windowing the entire floor, the table will filter out everything but spaces.

Pick two points diagonally to size the table. The resulting table lists each space on the
first floor with corresponding Gross, Net and Usable Areas, Net to Gross Percent
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and Lease Totals. Note that schedule tables can read all attached xrefs and even an
external drawing. This means you can generate a total for the entire building, rather
than just one floor.

Organising Areas

The Space object is useful, but it has limitations. Although many organisations will
lease areas and charge them back to the respective departments/cost centres that use
them, ADT Spaces cannot be organised into a hierarchy that reflects this arrangement.
In contrast, the Area object has these capabilities.

Area creation

In order to define an area, you select the Area tool in the Document tool palette. You
can form an area in three ways:

1. Pick points and close (similar to polyline command).

2. Right-click on the Area tool and select Apply Tool Properties
To...Linework and AEC Objects (You can then select a slab or any objects
representing the required area).

3. Right-click on the Area tool and select Apply Tool Properties To...Auto-
detection. You select objects, such as walls, that define the boundary. Then,
press Enter and Pick the internal point(s).

You can define an area in terms of its effect on the total area: additive or subtractive.

Area Appearance

You can also vary the appearance of an area to distinguish its function. Right-click on
any area and select Copy Area Style and Assign... This creates a new area style
identical in properties to the original and applies it to the selected area object.

For instance, you may wish to change the hatch pattern. On the Display Properties
tab, click on the Style Override checkbox and then the Properties button. On the
Layer/Color/Linetype tab, you can select colours for the Additive and Subtractive
hatching and boundaries.

Area Subtraction

You may need to include vertical penetration in your area assessment. To subtract one
area from another, create area within the boundary of another. Right-click the larger
area, select AEC Modify Tools» Subtract. Now select the smaller area(s) and press
Enter. ADT creates an internal boundary to reflect the subtraction.
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Grouping Areas

The distinct advantage of using area objects is the ability to organise them into area
groups. Area groups are used to represent the use and assignment of space within one
or more buildings to various organisational units. An area group could represent a
department, tenant or cost centre. They can be used to apportion the maintenance and
service charges of building common areas. Groups can also track the assignment of
rooms and moveable assets, such as computers and furniture.

To add an area group, go to Document® Area Groups» Add Area Group...
Now pick a point on screen to locate the area group icon.

To distinguish groups, you can create a new area group style and assign a color in
Display Properties.

In the sample file, db_sampl.dwg, I have assigned cubicles and offices to various
departments. Note that the Area schedule requires an R/U Ratio. This formula is held
in a Calculation Modifier Style. As you are aware, BOMA is floor-by-floor and does
not support the use of a single R/U ratio for the entire building.

You apply one or more calculation modifier by selecting from a list in the Properties
Window for any area or area group. Examples include plaster deduction, building
common area factors and chargeback rate as a function of the area or perimeter value.
You can also present the resulting values in the area schedule.

Display Themes

Display themes assign colors to ADT objects based on property set criteria.

For instance, a property definition named VACANCY could be assigned to tenant
offices. You can create a display theme to present all vacant offices in yellow. You
get a visual report of occupancy.

Equally, you could assign a property definition named REFRESH_DATE to all
computers. The display theme could apply red to every computer that is due to be
refreshed in the next month. The one proviso is to use an ADT Multi-view block
rather than an AutoCAD block.

Please review the sample file, db_samp1.dwg to see this feature in operation. Try
changing the criteria by altering the Display Theme style parameters.

10
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Asset Tracking

Many facility managers are flooded with requests for temporary use of shared
space/equipment. In open plan offices, conference rooms are booked for private
meetings. The provision of hot desks for visiting staff requires careful scheduling.

What of the numerous types of AV equipment, desks and chairs? With a myriad of
bookings, the tracking of assets can become unmanageable.

Earlier in this document, I mentioned the Location Property Definition. The location
property reads property data (e.g., Name) from the space or area that encloses a block
that represents an asset.

You can assign this property to an ADT Multi-View Block representing furniture,
equipment and computers. Typically, I would add Requestor_Name, Date_Fulfilled
and Date_Returned to the Property Set. This should match similar fields added to
your asset booking database.

Right-click on any MVBlock in the drawing and select Properties. In the Properties
Window, select the Extended Data tab. You can use the Insert Field... right-click
option to populate this property data from your database.

When an asset request is submitted, you move the block (in ADT) to its new location
on the drawing. You then fill in the Requestor_Name and Date_Fulfilled fields in
the database. These are automatically updated on the drawing.

The area name and property set data can be extracted to a schedule. To locate the
asset on the drawing: right-click on the table and select Edit Table Cell. To find an
asset in your schedule, you use Ctrl-Select to Zoom.

Publishing your Reports

I would recommend DWF as the best format for publishing your reports. Drawing
Web Format allows non-AutoCAD users to view and print your asset reports and
colour plans.

Should you wish to integrate database reports, you can download the DWF Writer
print driver from the Autodesk website. This allows you to print to DWF from any

application.

You can then merge these electronic prints into a multi-sheet DWF using DWF
Composer. Within the multi-sheet DWF |, you can also vary the sheet order.

You can also use an ActiveX control to embed this into an html web page with ease.

11
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Conclusion

Customisation of ADT Documentation features allow you to extend the value of the
application beyond mere drawings. You can do this without complex programming
knowledge. We have seen how you can integrate booking systems, work order
requests and asset reports.

I have introduced the core methods for doing this within ADT2006. My hope is that

you will begin to explore the use of ADT2006 as a tool for managing your assets
more effectively.
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